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Cisco Voice Services Provisioning Tool 
Overview

Cisco PGW 2200 Softswitch provides the framework for delivering voice services over packet-based 
data, voice, and video networks. 

Cisco PGW 2200 Softswitch encompasses a broad range of hardware platforms and Cisco software, 
delivering a continuum of voice solutions from core infrastructure to enhanced services over circuit and 
packet networks. The Cisco PGW 2200 Softswitch is at the center of Cisco PGW 2200 Softswitch 
solutions.

Provisioning a Cisco PGW 2200 Softswitch is preparing it to communicate with an SS7 network, with 
Cisco media gateways, and with the other components of an Cisco PGW 2200 Softswitch solution. The 
Cisco Voice Services Provisioning Tool (Cisco VSPT) provides an easy-to-use graphical tool for 
provisioning Cisco PGW 2200 Softswitches. 

Individual releases of the Cisco VSPT are designed to be used with specific releases of the 
Cisco PGW 2200 Softswitch software. 

Cisco VSPT Release 2.8(1) is designed to be used with Cisco PGW 2200 Softswitch Release 9.8(1). If 
you are using a different release of the Cisco PGW 2200 Softswitch software, see the “Determine the 
Correct Provisioning Tool Release” section on page 2-1 to identify the release of Cisco VSPT that you 
need.

Cisco MGC Node Manager (MNM) provides fault and performance management for 
Cisco PGW 2200 Softswitch, Cisco HSI, Cisco BAMS, Cisco Catalyst switches and Cisco IP Transfer 
Point LinkExtender (ITP-L). Cisco VSPT Release 2.8(1) is shipped with Cisco MNM 2.8(1).

This chapter introduces the Cisco VSPT and provides directions for obtaining, installing, and using the 
software. It contains the following sections:

• Provisioning Introduction, page 1-2

• Cisco VSPT Introduction, page 1-2

• Cisco VSPT Basics, page 1-3

• Starting the Cisco VSPT, page 1-11

• Using the Cisco VSPT, page 1-13

• Defining Users and Permissions, page 1-15

• Exiting the Cisco VSPT, page 1-16
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Provisioning Introduction
All solutions involving the Cisco PGW 2200 Softswitch are configured through the use of one or more 
Cisco PGW 2200 Softswitch hosts, one or more Signaling System 7 (SS7) network signaling options, 
and one or more media gateways that control bearer-traffic routing. 

Note In this document, a solution is a logical combination of Cisco hardware and software, configured to 
perform a specific network task.

Before starting a provisioning session, you must understand the network topology for your solution. 
Create a network drawing, and refer to it while configuring your network.

You should also perform the following tasks before starting a provisioning session:

• Plan your network configuration. See the documentation for your solution for detailed network 
configuration information.

• Set up your system hardware, and install all required software. For more information, see 
“Prerequisites” in Chapter 1 of the Cisco Cisco PGW 2200 Softswitch Hardware Installation Guide, 
and the Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide at

http://www.cisco.com/en/US/products/hw/vcallcon/ps2027/prod_installation_guides_list.html

Cisco VSPT Introduction
The Cisco VSPT allows you to import an existing configuration, modify the configuration, and export it 
to the same or different devices. The Cisco VSPT can also help you to provision individual call 
parameters. This simplifies the provisioning of a large live network.

Using the Cisco VSPT helps avoid common errors that might arise if devices are provisioned 
independently. It eliminates the need to enter duplicate data, and enables you to import and export 
configurations.

The Cisco VSPT generates configuration files necessary to provision the Cisco PGW 2200 Softswitch, 
including the following provisioning information:

• Signaling

• Trunk groups

• Trunks

• Routes

• Dial plans

During a provisioning session, the Cisco VSPT automatically generates the Man Machine Language 
(MML) or command line interface (CLI) scripts used to configure network elements. It assembles these 
commands into a batch file and deploys the file to the appropriate network device. 

The Cisco VSPT allows scheduled backups and restores of configurations on the following devices:

• Cisco PGW 2200 Softswitch Host—Active configuration or entire Cisco PGW 2200 Softswitch 
system

• Catalyst 2900XL—Running-config and image in Flash

• Catalyst 5500—For switch module and RSM, configuration and image in Flash

• Catalyst 6509—For switch module and MSFC, configuration and image in Flash
1-2
Cisco Voice Services Provisioning Tool User Guide

OL-18341-02

http://www.cisco.com/en/US/products/hw/vcallcon/ps2027/prod_installation_guides_list.html


 

Chapter 1      Cisco Voice Services Provisioning Tool Overview
  Cisco VSPT Basics
• Cisco ITP-L 2600—Running-config and image in Flash

• Cisco BAMS Phase 3—Active configuration

• Cisco HSI Adjunct Server 4.3—Active configuration

Cisco VSPT can support secure communications to SSH-enabled devices, the 
Cisco PGW 2200 Softswitch host, the Cisco BAMS server, or the Cisco HSI server. 

The following operations can use SSH: 

• Provisioning of an SSH-enabled Cisco PGW 2200 Softswitch

• Launching of SSH rather than Telnet for communicating with SSH-enabled network devices through 
a command-line interface

• Use of SSH to secure X windows communications with the end-user display device

• Use of SSH in place of Telnet for the initial step (logging in to the component to be backed up and 
getting the configuration) in a backup and restore operation. TFTP is used for MML configuration 
backup and restore. FTP is used for system backup and restore.

The Cisco VSPT can be deployed as an integrated component of the Cisco MNM or as a standalone 
application. If it is installed on the Cisco PGW 2200 Softswitch host, call throughput might be affected 
when the Cisco VSPT is active. 

Cisco VSPT typically runs on a standalone UNIX server that is also running the Cisco MNM and 
supports multiple users and provisioning sessions. 

You can launch the Cisco VSPT from the managed object icon in the Cisco MNM Map Viewer. For 
information about Cisco MNM, see the Cisco MGC Node Manager User Guide at:

http://www.cisco.com/en/US/products/sw/netmgtsw/ps1912/products_user_guide_list.html

This document is designed to help you get started using the Cisco VSPT and does not include complete 
provisioning instructions, which are found in Chapter 3, Provisioning with VSPT, in the 
Cisco PGW 2200 Softswitch Release 9.8 Provisioning Guide at:

http://www.cisco.com/en/US/docs/voice_ip_comm/pgw/9.8/Provisioning/Guide/R9GUI.html

Chapter 3, Provisioning Dial Plans with the VSPT, in the Cisco PGW 2200 Softswitch Release 9.8 Dial 
Plan Guide is at
http://www.cisco.com/en/US/docs/voice_ip_comm/pgw/9.8/Dial_Plan/Guide/DP_VSPT.html

Cisco VSPT Basics
This section describes the requirements for entering provisioning data using the Cisco VSPT.

VSPT Field Definitions
Table 1-1 lists Cisco VSPT field names that correspond to system components in the 
Cisco PGW 2200 Softswitch, and their definitions. For more information about system components, see 
the Cisco PGW 2200 Softswitch Release 9.8 Provisioning Guide.

This table is not a comprehensive list of provisioning components. It is a description of the major fields 
displayed in the MGC Config window.
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.
Table 1-1 Field Definitions in the MGC Config Window

Field Name Definition

MGC Hosts Basic information for Cisco PGW 2200 Softswitch and Cisco BAMS, for 
example, hostname, IP addresses, Cisco PGW 2200 Softswitch mode, and 
etc.

Point Codes

Adjacent Point 
Code (APC)

Address of an STP1 that sends and receives signaling messages to and from 
the Cisco PGW 2200 Softswitch

Destination Point 
Code (DPC)

Address of an endpoint, such as a PSTN2 switch that carries the bearer traffic

Originating Point 
Code (OPC)

Originating point code (OPC) is the address for the 
Cisco PGW 2200 Softswitch.

Routing Keys

M3UA Route 
Key

Transpath NE component that represents the M3UA Routing key, a child of an 
OPC

SUA Route Key Transpath NE component that represents an SUA Routing key, a child of an 
OPC

Location Label Call Limiting value settings

LinkSet Set of links from the Cisco PGW 2200 Softswitch to an endpoint, such as an 
adjacent STP

SS7 Subsystem Logical connection between a pair of mated STPs that allows the 
Cisco PGW 2200 Softswitch to route through either STP to an endpoint

ISUP Timer Profile

(Moved to Traffic 
Window > Profile in 
Release 2.8(1))

ISDN User Part (ISUP) timer profile provisioned for signaling service.

Inservice Intelligent network services table that can be changed at any time and is 
dynamically reconfigurable

SS7 Path (SS7 
Signaling Service)

Connection between the Cisco PGW 2200 Softswitch and a specified point 
code

SS7 Route Route for each signaling path from the Cisco PGW 2200 Softswitch to the 
PSTN switch through the linksets you have created to the STPs

IP Route Static IP route

M3UA Route This field contains routes for each signaling path from the 
Cisco PGW 2200 Softswitch to the PSTN switch through the SGNode using 
M3UA. The external node type VXSM is supported. 

SUA Route Route for each signaling path from the Cisco PGW 2200 Softswitch to the 
PSTN switch through the SGNode using M3UA

SS7 Signaling Gateway

SS7 SG Nodes SS7 signaling gateway nodes

SS7 SG Pairs SS7 signaling gateway pair

SS7 SG 
Subsystem

SS7 signaling gateway subsystem
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SS7 SG Sigpaths SS7 service to a signaling gateway

Line Number 
Translation

Line number translation represents a line number and internal number 
translation and is dynamically reconfigurable.

SIP

DNS DNS server related information, including IP address, cache size and other 
parameters

Insipheader Inbound SIP header table defines a set of inbound SIP headers and 
corresponding actions. It allows you to customize the actions of 
Cisco PGW 2200 Softswitch based on defined inbound SIP header values.

Outsipheader Outbound SIP header table defines a set of outbound SIP headers and 
corresponding actions. It allows you to customize the actions of 
Cisco PGW 2200 Softswitch based on defined outbound SIP header values.

SIP Path SIP Path is the SIP signaling service which connects a 
Cisco PGW 2200 Softswitch and a SIP server.

Auto Congestion Ctrl

Response 
Category

Auto Congestion Control response categories that may be associated with a 
trunkgroup or a signaling path

MCL Threshold Definition of onset and abate values of different contributing factors for 
Machine Congestion Level (MCL)

MCL Callreject The definition of call reject percentage in different MCLs

Advice of Charge

Holiday Holiday table allows you to distinguish specific days of the year and charge 
them differently from the actual day of the week that the holiday falls on.

Charge Charge table defines the tariff rates (table index key for tariff.dat) and their 
durations.

Tariff Tariff table contains the tariff rates and scale factors. Each row is referenced 
by a tariff ID that call processing obtains by accessing the Charge table.

Meter Tariff Meter Tariff table is indexed by the tariff identifier retrieved from the charge 
table. The charge result type from generic analysis indicates which type of 
tariff table is accessed. 

Pricharge Pricharge table stores the charge information retrieved from the charge table. 
It is also used to generate AOC charge information for the subscribing user.

Pritariff Pritariff table stores the tariff information retrieval from tariff table. It is also 
used to generate AOC charge information for the subscribing user.

GTD Parameters GTD (generic transparency descriptor) transports ISUP messages and 
parameters, using a generic format, between the ingress and egress 
Cisco PGW 2200 Softswitches.

TOS Type of service

SIPIVersion SIP-I version table stores SIP-I profile, SIP-I version, and the associated 
MDO. Cisco PGW 2200 Softswitch uses this table to process or send out 
SIP-I messages.

External 3Nodes

Table 1-1 Field Definitions in the MGC Config Window (continued)

Field Name Definition
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Association An SCTP association represents the connection between the 
Cisco PGW 2200 Softswitch and a Cisco access server.

Association for 
H.248

An SCTP4 link for H.248 signaling service

BRI A QSIG/Q.931 over BRI backhaul signaling service

C7 IP Link Links to the SS7 network (for example, an SSP5 or STP) from 
theCisco PGW 2200 Softswitch through a Cisco ITP-L.

CTI CTI signal path.

DPNSS DPNSS6 signaling path is backhauled over IP to/from a Network Access 
Server (destination).

EISUP EISUP signaling service or signaling path. The signaling path to an externally 
located Cisco PGW 2200 Softswitch (destination).

H.248 Signaling 
Service

Another signaling service (in addition to MGCP) between the 
Cisco PGW 2200 Softswitch and the VXSM media gateways

IPFAS An IPFAS signaling service

IP Link for H.248 An UDP7 link for H.248 signaling service

IP Link for 
MGCP 

Links for the MGCP signaling services.

ITP Internet Protocol Transfer Point (ITP) is a signaling gateway to the SS7 
network.

LI Lawful Intercept (LI) mediation device signal path

MGCP8 
Signaling Service

Signaling service between the Cisco PGW 2200 Softswitch and a media 
gateway 

NASPath Network access server (NAS) signaling path, the Q.931 protocol path between 
the Cisco PGW 2200 Softswitch and the media gateway

Rapath RADIUS9 accounting server signal path

Raserver RADIUS accounting server

Sessionset A pair of backhaul IP links used on the Cisco PGW 2200 Softswitch to 
communicate with external nodes that support IPFAS or BSMV0

SGP Signaling gateway process

CTI Manager CTI manager details, including IP addresses, ports and other parameters

AXL Server AXL server details, including IP addresses, ports and other parameters

1. STP = signal transfer point.

2. PSTN = Public Switched Telephone Network.

3. External Nodes = Any object in the network that is connected to the Cisco PGW 2200 Softswitch. For example, media 
gateways (Cisco MGWs) and associated Broadband Service Cards (BSCs).

4. SCTP = Stream Control Transmission Protocol.

5. SSP = service switching point.

6. DPNSS = Digital Private Network Signaling System.

7. UDP = User Datagram Protocol.

8. MGCP = Media Gateway Control Protocol.

Table 1-1 Field Definitions in the MGC Config Window (continued)

Field Name Definition
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Table 1-2 describes the major fields displayed in the Traffic window when the 
Cisco PGW 2200 Softswitch is in switched mode. Table 1-3 describes the major fields displayed in the 
Traffic window for nailed-mode Cisco PGW 2200 Softswitches.

9. RADIUS = Remote Authentication Dial-in User Service.

Table 1-2 Field Definitions in the Traffic Window (Switched-mode Cisco PGW 2200 Softswitch)

Field Name Definition

Profiles Profile table stores all kinds of service profiles, for example, SIP profiles, 
EISUP profiles, common profiles, domain profiles, and so on. A profile 
allows you to define a collection of properties and associate trunk groups, 
domains, or other components with that profile accordingly.

Domain The domain table defines the domain profile that is associated with a given 
domain name. The domain table contains a direction (inbound or 
outbound) and a pointer to a domain profile for each domain name

Trunk Groups A trunk group is a collection of DS0 circuits arranged so that dialing a 
single trunk number provides access to the entire trunk group.

Gateway Pool Gateway pool table stores information for gateway pools. A set of border 
gateways with the same capabilities is organized as a gateway pool. A 
gateway pool entry in the table has a gateway pool ID, a gateway pool 
profile, and a list of gateways.

Trunks A trunk is an individual circuit (DS0) on a T1/E1.

Ipinmapping This is an IP IN Trunk mapping which maps an inbound SIP or H.323 call 
to a trunk group. 

CodecString A series of codec choices separated by semicolons

BearerCap Users can define a required bearer capability (ies) and include that 
definition here. Calls with a specific bearer capability could then be 
preferentially routed to this route.

ATMPRofiles ATM profiles are used on the Cisco PGW 2200 Softswitch to change the 
network Service Level Agreement.

Routing

Routes A route is a collection of trunk groups associated with the same set of 
dialed digits.

Route Lists A route list is a collection of routes that go to the same endpoint.

Descriptions Users can add time conditional routing descriptions. 

Conditional Routing Users apply the above descriptions to distribute the traffic load on Monday 
through Sunday and other specified holidays.

Percentage Routing The percentage routing permits the user to distribute the traffic load across 
route lists based on assigned percentage values.

Table 1-3 Field Definitions in the Traffic Window (Nailed-mode Cisco PGW 2200 Softswitch)

Field Name Definition

Trunks A trunk is an individual circuit (DS0) on a T1/E1.
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Table 1-4 describes the major fields displayed in the Number Analysis window.

Table 1-4 Field Definitions in the Number Analysis Window

Field Name Definition

Dial Plans

Dial Plan Names

Results

Digmodstring The digit modification string is used to modify numbers in either the 
A-number (calling party number) or the B-number (called party number)

BC By changing the BC information elements (IEs) in the outgoing Initial 
Address Message (IAM), an ISUP call from the PSTN can be translated to 
a fax call in the Global System for Mobile Communications (GSM) 
network based on the dialed called party number. You need to create the 
BC table and add a BCMOD result in order to change the BC IEs in the 
outgoing IAM.

HLC By changing the High Layer Compatibility IE in the outgoing IAM, the 
Cisco PGW 2200 Softswitch translates an ISUP call from the PSTN to a 
data call in the GSM network. You need to create the HLC table and add 
the HLCMOD result in order to change the HLC IEs in the outgoing IAM.

Customervpnid The customer VPN ID overwrites the configured VPN ID in the incoming 
trunk groups or sigPaths.

Dmnmodstring The domain modification string table defines the string modifications on 
the domain names. 

Resultset The result of analysis might require that an action be taken. A result set 
defines that action or a set of actions.

DefResultset The default result set allows you to configure an action to occur if no result 
sets have been associated with the call.

Screening Call screening is a type of analysis done on the digit string to determine if 
the call is accepted or rejected.

Service The service names in the Service table are defined by the user to indicate 
services for screening that are available to the users. You must define a 
service before you add a B-number-triggered call screening.

SourceBlack The source domain blacklist table allows you to screen calls based on their 
source domain names.

DRPTable The domain routing policy (DRP) table allows you to define the result sets 
that the Cisco PGW 2200 Softswitch executes at a given step in the DRP 
table.

RouteSel The route selection table allows the Cisco PGW 2200 Softswitch to route 
calls based on the source and destination domain names. 

DestTrans The destination username/domain translation table translates the 
non-E.164 destinations to E.164 destinations (domains to phone numbers).

Triggers
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Achgorigin The Cisco PGW 2200 Softswitch returns a result with CHARGEORIGIN 
result type during the A-number analysis if the Advice of Charge (AOC) 
feature is enabled on the ingress trunk group or sigpath. You need to add 
A-number charge origin data before you add a result with 
CHARGEORIGIN result type.

Adigtree The Adigtree table is the analysis table for calling numbers (A-numbers). 
You add data to it by defining an entry for each digit in the digit string.

A-Num Dp Selection The dial plan selection table provides the functionality to select a new dial 
plan based on the customer group ID and the full A-number.

Bdigtree The Bdigtree table is the analysis table for called numbers. You add data 
to it by defining an entry for each digit in the digit string.

Cause The Cause table lists the cause codes generated when a call is either 
rejected or cleared by the system. The cause for release can be from either 
a result type (from either B-number analysis or cause analysis) or a failure 
(generated during call processing).

Cliprefix Advanced screening on the Cisco PGW 2200 Softswitch requires the 
provisioning of the calling line identification prefix table. The CLI prefix 
parameter allows you to associate a CLI prefix with a specific customer 
group. If an incoming call matches the CLI prefix parameter, you can apply 
certain dial plan functions to it.

CliIpAddr The advanced screening and modification on CLI IP address parameter 
allows you to associate an IP address with a cliset name. If the source IP 
address of the incoming call message matches the provisioned IP address, 
the Cisco PGW 2200 Softswitch selects the CLI set. If that incoming call 
matches an CLI prefix defined in that cliset, the 
Cisco PGW 2200 Softswitch selects the customer group ID of that CLI 
prefix entry to continue the number analysis.

CPC Pre-analysis is the first phase in the Cisco PGW 2200 Softswitch number 
analysis. CPC analysis is the first stage of the pre-analysis. Users configure 
a CPC table so that it links CPC values received from the incoming call 
setup message to a result.

DP Selection The dial plan selection functionality enables the 
Cisco PGW 2200 Softswitch to divert from one dial plan to another one 
under specific conditions. You need to add dial plan selection data before 
you use this function.

H323iddivfrom The h323iddivfrom parameter allows you to associate an H.323 ID with a 
specific customer group. If an incoming call matches the H.323 ID 
parameter, you can apply certain dial plan functions to it.

Location The Location table is used to identify an associated result set. This table is 
accessed from the cause table through the location index. The location 
index is used to refer to a block of 16 entries in the location table. The 
location value is used as an offset into the location block. An action can be 
associated with a specific location value by associating a result set with the 
value in the location block.

Table 1-4 Field Definitions in the Number Analysis Window (continued)

Field Name Definition
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Anoa The NOA table is used to define actions to be taken, based on the incoming 
A-number NOA.

Bnoa The NOA table is used to define actions to be taken, based on the incoming 
B-number NOA.

Anpi The A-number NPI table is used to identify an associated result set. This 
table is accessed from the A-number NOA table through the NPI block.

Bnpi The B-number NPI table is used to identify an associated result set. This 
table is accessed from the B-number NOA table through the NPI block.

RTE Holiday The holiday table allows you to select specific days of the year to be routed 
differently from the actual day of the week that a holiday occurs on.

TMR The TMR analysis is the second stage in Pre-analysis that enables 
analyzing the TMR value in the IAM or Setup message. For example, this 
would allow the Cisco PGW 2200 Softswitch to set different media 
gateway bearer capabilities within the network.

TNS The TNS analysis is the fourth stage in Pre-analysis that enables analyzing 
the TNS values. For example, this would allow the 
Cisco PGW 2200 Softswitch to set different media gateway bearer 
capabilities within the network.

Global Items

Announcement The ToneAndAnnouncement database table contains all the announcement 
details. An announcement ID identifies the announcement.

Porttbl

(Moved to Tools> 
Advanced Number 
Editor in 
Release 2.8(1))

The ported number table contains ported numbers. If the presented 
B-number is found in this table, the call is rerouted to the recipient 
network. 

Script To support the MGCP scripting feature on the 
Cisco PGW 2200 Softswitch, you need to provision a script table.

FullNumberTrans The full number translation table is used for the result type NUM_TRANS. 
The NUM_TRANS result type is returned from A-number (the calling 
number) or B-number analysis (the called number) indicating that one or 
more numbers encountered require full replacement. The full number 
translation table contains all the replacement information.

Termtbl

(Moved to Tools> 
Advanced Number 
Editor in 
Release 2.8(1))

The number termination table contains B-numbers. If the presented 
B-number is found in this list, the call is routed to the RouteID associated 
with the corresponding digit string.

Testline The test line table is used to specify the delay, loop requirement, duration, 
and other parameters for test calls.

Table 1-4 Field Definitions in the Number Analysis Window (continued)

Field Name Definition
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Cisco VSPT Data Entry Requirements
When you are entering data into the Cisco VSPT windows, follow standard MML conventions for names 
and descriptions. Each MML name must have the following characteristics:

• A maximum of 20 alphanumeric characters, including dashes

• No space, underscore, or special characters

• Must start with an alphabetic character

For example: name="dpc1"

MML descriptions can be as many as 128 characters and can include spaces and symbols. You should 
use a description that helps to identify the component or link that you are provisioning. 

For example, for an SS7 route, which indicates the signaling path from the Cisco PGW 2200 Softswitch 
to a switch through a linkset, you could create a description “SS7 Route to PSTN Switch A through 
Linkset 1.”

For more information about MML, see the Cisco PGW 2200 Softswitch Release 9 MML Command 
Reference.

The Cisco VSPT GUI enables you to go through the provisioning process in sequence. The sequence of 
steps is described in the Cisco PGW 2200 Softswitch Release 9.8 Provisioning Guide.

Starting the Cisco VSPT
To start the Cisco VSPT, use this procedure:

Note If you encounter any font problems in VSPT, start VNC server using 
-fb /user/openwin/lib/X11/fonts/misc/ as the command arguments.

Step 1 Do either of the following to start Cisco VSPT:

• Start VSPT standalone

a. Log in to the Cisco VSPT server or access it from a machine with X window capability.

b. In a terminal window, change to the default directory:

% cd /opt/CSCOvsp28

Note Navigate to the appropriate directory if you installed the Cisco VSPT in a different location.

c. Enter the following command to start the Cisco VSPT:

% ./vspt

•Start Cisco VSPT from Cisco Media Gateway Controller Node Manager (Cisco MNM)

a. Before starting Cisco MNM, log in as root.

b. Right-click the MGC host object in the Map Viewer and choose Tools > Voice Service 
Provisioning Tool (VSPT)
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Note If you start the Cisco VSPT from Cisco MNM, the correct Cisco VSPT version is automatically 
launched to match the selected Cisco PGW 2200 Softswitch. You must have that version of 
Cisco VSPT installed before you launch it on the MGC host object from Cisco MNM.

The login screen shown in Figure 1-1 appears.

Figure 1-1 Login Screen

Step 2 Enter your user name and password and click OK.

The default user name is admin, and the password is also admin. 

Note Cisco VSPT checks the license and provides the expiry date for that license after you provide 
the login information.

The Welcome screen is displayed briefly during the login process, and the Main VSPT window appears 
(see Figure 1-2).

Figure 1-2 Main Cisco VSPT Window
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Using the Cisco VSPT
This section describes the Cisco VSPT menus and Configuration Editor views and gives instructions for 
using the tool functions.

Menus
The Cisco VSPT menu bar contains these menus:

• File

• View

• Tools

• Help

These menus are described in the following sections.

File Menu

Table 1-5 describes File menu commands.

View Menu

Table 1-6 describes View menu commands.

Table 1-5 File Menu Commands

Command Description

New Begin a new configuration session

Open Open an existing configuration

Import Import an existing configuration from an Cisco PGW 2200 Softswitch, or import 
trunk group, trunk, routing, or dial plan files into the Cisco VSPT

Export Export configuration files from the Cisco VSPT to a specified directory

Save Save the current configuration:

• As Working: Use to save a new configuration, either a configuration 
imported from the Cisco PGW 2200 Softswitch or a configuration created in 
Cisco VSPT. Use also to save modifications to an existing configuration, 
overwriting the last version.

The configuration is saved in the /var/opt/CSCOvsp28/data/mgc/mistral 
directory.

• As Snapshot: Use to save modifications to an existing configuration under 
a new name in the ARCHIVE directory. The snapshot configuration is saved 
in /var/opt/CSCOvsp28/data/mgc/mistral/configname/ARCHIVE.

• As New Config: Use to save a modified configuration under a new name, 
leaving the original intact. 

Exit Stop any open provisioning sessions and close the Cisco VSPT.
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Tools Menu

Table 1-7 describes Tools menu commands.

Help Menu

Table 1-8 describes Help menu commands.

Table 1-6 View Menu Commands

Command Description

MML Show generated MML for the current configuration

Trunk Group File Show generated trunk group file for the current configuration

Trunk File Show generated trunk file for the current configuration

Table 1-7 Tools Menu Commands

Command Description

Integrity Check Check your configuration for inconsistencies and missing information.

Deploy Move the configuration to one or more target hosts.

Remote Shell Open a Telnet or SSH session.

MGC Viewer View, activate, remove, and synchronize configurations on the 
Cisco PGW 2200 Softswitch.

BAMS Config View and configure a Cisco Billing and Measurements Server (BAMS). See the 
Cisco Billing and Measurements Server User’s Guide for your release of 
Cisco BAMS for information about its configuration.

State Operation View and configure the state of Cisco PGW 2200 Softswitch components.

Advanced Number 
Editor

View and configure screening numbers, ported number table, and the number 
termination table. See the Cisco PGW 2200 Softswitch Release 9.8 Dial Plan 
Guide for information about using the Cisco VSPT Advanced Number Editor. 

Audit Audit bearer trunk information between the Cisco PGW 2200 Softswitch and the 
Cisco BAMS.

Backup and Restore Create, modify, or delete scheduled backups or restores on the 
Cisco PGW 2200 Softswitch host, Catalyst 2900XL, Catalyst 5500, Catalyst 
6509, Cisco ITP-L 2600, Cisco BAMS P3, and Cisco HSI server components. 

Administrators

Change Password Change your password.

User Admin Add, modify, or delete users.

Table 1-8 Help Menu Commands

Command Description

VSPT User Guide View a local version of the Cisco VSPT User Guide.

About VSPT View information about the current version and patch level of Cisco VSPT, 
including the software release number.
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Configuration Editor Views
You create, view, and modify configurations using the Cisco VSPT Configuration Editor, which has 
three different views. 

To select a view, click one of the radio buttons at the top of the Configuration Editor window:

• MGC Config—MGC Configuration view. Use to add components and provision component 
properties.

• Traffic—Traffic view. Use to create customer-specific files, including trunk groups, trunks, and 
routing.

• Number Analysis—Number Analysis view. Use to provision dial plans.

In each view, the left pane displays selectable components in an Explorer-type tree view.

The right pane displays data entry fields for the selected component. 

Click a component to select it. To see all of the subcomponents for the component you select, click the 
icon next to the component name to expand the component list.

For instructions for using the Cisco VSPT to provision components, component properties, trunk groups, 
trunks, and routing, see the Cisco PGW 2200 Softswitch Release 9.8 Provisioning Guide. 

For instructions for using the Cisco VSPT to provision a dial plan, see the Cisco PGW 2200 Softswitch 
Release 9.8 Dial Plan Guide.

Defining Users and Permissions
After you install the Cisco VSPT, you define users and their respective permissions using the following 
procedure:

Step 1 Log in to the server as root. 

Step 2 Start Cisco VSPT, either by first starting Cisco MGC Node Manager and then starting Cisco VSPT, or 
by starting the Cisco VSPT standalone.

Step 3 Click Tools > User Admin.

The User Administration screen in Figure 1-3 appears.
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Figure 1-3 Cisco VSPT User Administration

Step 4 To add a user, do the following:

a. Enter a user name and a password.

b. From the Permission dropdown list, choose the desired permission level, viewer, user, or admin.

Note Admin—Can create, modify, and delete users. This type of user has full read and write accesses 
to all of the configurations on the Cisco BAMS, and the Cisco PGW 2200 Softswitch.
User—Cannot create, modify, or delete users. This type of user has full read and write accesses 
to all of the configurations on the Cisco BAMS, and the Cisco PGW 2200 Softswitch.
Viewer—Cannot create, modify, or delete users. This type of user has the read-only access to 
the Cisco PGW 2200 Softswitch configurations saved on Cisco VSPT but it has no access to the 
Cisco BAMS configurations saved on Cisco VSPT. It cannot access the configurations on the 
remote Cisco BAMS, or the Cisco PGW 2200 Softswitch.

c. Click Add.

To modify a user, select the user name, change the password or the permission level, and click 
Modify.

To delete a user, select the user name, and click Delete.

Exiting the Cisco VSPT
You can exit the Cisco VSPT by choosing File > Exit or clicking the X button in the upper right of the 
main window.
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